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*General Scoring* 

·        Added a prompt to reduce the number of overs in a two-innings match after a time-stopping break of 10 

minutes or more, which will open the Revised Overs/Target/DLS dialog with a new row and the Revised Overs 

box open (#1460) 

·        Added ability to set the date/time for resumption of play, or next ground/umpire inspection during a break, 

which will display on Match Centres and live streams, including auto prompts when appropriate controlled by a 

configuration option (#197) 

·        Added an automatic Confirm Overs Remaining prompt in 4-innings matches to the Create Innings/Start of 

Play process, when resuming after a Rain interruption, and including Overs Remaining in Final Innings at start 

of the 4th innings (#5720) 

·        Added ability to record Penalty Runs as ‘Non-Ball Penalties’ when the penalty did not occur on a ball, 

e.g., pre-match/innings, during a session/rain break, or during play but not a ball incident (#1150) 

·        Added prompts to automatically recalculate DLS Revised Targets and Match Results when scoring 

changes are made, e.g., adding Penalty Runs to the 1st innings when in 2nd innings, adding/deleting 1st Innings 

runs or wickets, etc (#2893 and #5860) 

·        Added support to re-calculate the Match Result after editing a match in such a way that this changes, e.g., 

deducting runs from an earlier innings or adding runs to the final innings (#6185) 

·        Added the automatic End of Innings prompt when Target Reached occurs with Penalty Runs (#6727) 

·        Added the ability to hide/show non-essential columns in the Ball by Ball panel, by right-clicking on the 

column headers or left-clicking on the Settings cog at the top-right of the panel to open a menu list to un/tick, re-

size their width by click/hold/drag on their headers, and to move them by drag and drop to another location 

(#829) 

·        Added an automatic Innings Note to the start of the third innings after the Follow On has been enforced 

(#5275) 

·        Added an overs.ball remaining in Power Play field to all scoreboard XML templates (#6940) 

·        Added the maximum number of overs per innings in a two-innings match by default to the Revised Overs 

(or Balls) column when accessing the Revised Overs (or Balls)/Target/DLS dialog pre-Toss/Innings (#5819) 

·        Added support for Overs per Day being set on a 4-innings Match Type after a match has been started, 

including the correct changing of that value during the match, so that Overs Remaining in Day are calculated 

and displayed correctly (#5364) 

·        Added a prompt asking if a Revised Target should be added and a Match Result calculated when using 

Play Called Off to end an innings, after the minimum number of overs, as likely shortened match details have 

not been entered and Match should not end with “No Result” (#6729) 

·        Added a dynamic tooltip showing the updated fielding position when moving the cursor over the Wagon 

Wheel, and defaulting any Ground Field attributed to a Fielder to the fielding position of a created Wagon 

Wheel (#565) 

·        Added ability to manually enter Speed Radar values (mph or kph), with the entry panel available from 

View -> Scoring Entry, Ball by Ball column available from the Settings cog, and data available within Stats 

Wizards (#6726 and #8091) 

·        Added off-side and leg-side Wide guidelines to the Ball Arrival panel (#6031) 
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·        Included the Follow-On Deficit figure (editable) in this Confirm Overs Remaining prompt, so that it is 

more visible and especially so at the start of the 2nd innings to confirm this is correct for the Match Type (#798) 

·        Improved the prompts and added yellow highlights when creating a match without a Captain and/or 

Wicketkeeper, as seeing Add Players instead of Record Toss but a full list of players was not always obvious 

(#1666) 

·        Improved the keyboard navigation on the New Match dialog, so that using the Tab key to move around the 

dialog features is logical and consistent with other such dialogs (#5162) 

·        Improved the Edit -> Insert/Add Ball process by automatically adding the mid-point time between the 

Previous and Next Balls, which can then still be changed via Edit Ball Time if required (#6515) 

·        Improved the Edit Ball Time process by adding warnings if a proposed change will result in ball 

timestamps becoming out-of-sequence, and cancelling will return the Ball Time to the original (#3904) 

·        On the Wicket dialog, enabled the End Ball checkbox when the Dismissal Type is Hit the ball Twice, so 

that this can be un-ticked as these dismissals can occur on a no ball (#7912) 

·        On the Detailed Fielding Events list of positions, moved Cover Point to its correct location between Deep 

Point and Short Cover (#7415) 

·        General improvements to the Detailed Fielding Events dialog, e.g., enabling/disabling the Add button 

depending on data already added, adding/removing data to or from separate rows, and avoiding duplicate entries 

(#2584) 

·        Darkened the Wagon Wheel slider/toggle for improved visibility in bright sunlight (#4107) and also 

lightened the green on the Wagon Wheel itself (#1062) 

·        In Edit mode, the Edit Over/Ball button menu and the Ball by Ball right-click menu now show “Insert Ball 

(Before)” and “Add Ball (to End)” to specify where an inserted ball and an added ball will appear in the 

sequence (#4742) 

·        In Player Averages, changed the calculation of a Player’s Team Percentage (Tm%) to use their total runs 

divided by the team’s total runs in the innings they batted, rather than averaging their percentages (#6591) 

·        In Player Averages, excluded wicketkeeper catches from the Catches (Ct) column, so that these only 

appear in the Wicketkeeper Catches (C+) column (#6977) 

·        After clicking Add to enter a penalty, the Penalties dialog will now automatically close, rather than having 

to click Add and Close (#4685) 

·        Changed the ball-by-ball symbols in This Over, Batsman’s sequence, and Match Centre, etc, to show No 

Balls first and then Byes, Leg Byes, or Runs, as these happen first, but Wicket is prioritised when these fall with 

extras or runs (#3928) 

·        Removed the Play State -> In Play menu option when in the Pre-Start mode, i.e., after Record Toss but 

before Create Innings, to force the creation of this first rather than switching manually to In Play (#7784) 

·        Renamed Innings 3 and Innings 4 as [Batting Team] Super Over throughout the software, e.g., Scorecard 

with notes enabled, Scorebook, and all Statistics menu (Partnerships, Over by Over, etc) reports in Tied matches 

with Super Overs (#5256) 

·        When editing consecutive breaks, either pre-match/innings or during an innings, changing the Start Time 

on a subsequent break will automatically update the End Time of the preceding break, and vice versa (#4842) 



*ECB PCS Pro 3.1.3 to 4.0.3 (Production)* Copy of Release notice issued 11mar21    Page 3 of 8 

·        Increased maximum size of Diagnostics folders than can be sent, and added a message informing the user 

if this is exceeded and the Diagnostics folder has not been sent (#7526) 

·        Added a warning prompt that the software is already open when attempting to open it again, with the 

option to close the first instance (Yes) or stop the second instance opening (No), as only one instance can be 

open at a time (#7725 and #6779) 

   - Fixed issue where the bowler for a new over would revert to the bowler    of the previous over at that end, 

when either using Escape or Undo on that    first ball of the new over (#7695) 

·        Fixed issue where a session break’s end time would automatically update to the end of innings time, so 

workaround of manually updating via Scoring -> Breaks/No Play State no longer required (#6860) 

·        Fixed issue where pre-match automated Innings Notes were displaying out-of-order on the Match Centre 

in some situations, e.g., multiple Rain & Ground Delay breaks (#7434) 

·        Fixed issue where Edit -> Insert Ball would highlight the current and inserted balls in blue in the Ball by 

Ball panel, and remain that way after exiting Edit mode (#5894) 

·        Fixed issue where an abbreviated Team Name at match level only would not carry through to the auto-

Tweet content (#6451) 

·        Fixed issue where an abbreviated Player Name at match level only would not carry through to the auto-

Tweet content, video playlists, or Match Centre (#6859) 

·        Fixed issue where the DLS output at the end of an innings/match would display the End of Over value for 

the next over after the maximum overs had been reached (#6852) 

·        Fixed issue where adding Penalty Runs to a fielding team who have already batted, with Add to Previous 

Ball un-ticked, did not award the runs to the previous innings, and undoing a ball with penalties did not remove 

them as well (#3925) 

·        Fixed issue where scoring a Run Out (Backing Up) added a ball to the Striker’s balls faced and 

Partnership balls (#3908) 

·        Fixed issue where Illegal Balls were added to a Batsman’s balls faced, and applied excluding all the 

different types of Illegal Balls from counting in all places, i.e. balls faced, partnership balls, innings balls, and 

overs bowled (#2898) 

·        Fixed issue where the match reduced Innings Note was not retained if Revised Overs was entered then the 

innings ended and would not appear if End of Overs was used without Revised Overs being entered (#6199) 

·        Fixed issue where a hattrick or double-hattrick was incorrectly added to the batting notes instead of the 

bowling notes on the Scorebook view (#6383) 

·        Fixed issue where deleting a Shirt Number from a Player Record did not Save correctly (#5994) 

·        Fixed issue where using the Edit Over/Ball menu to Add Ball (to End) of an empty over would cause a 

critical error crash (#7795) 

·        Fixed issue where the Scorecard and Match Centre would not update the total or bowler’s overs after 

using Insert Over and Add Ball to insert an over at the start of an innings (#6672) 

·        Fixed issue where the Confirm Bowler prompt would default to the first bowler of a part-over in the 

previous over, by removing them and their replacement part-over bowler from the dropdown (#3638) 
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·        Fixed issue, prior to the first innings, where in Play Control the bowler’s O and M labels would not appear 

and the One-Click Scoring panel would have an empty space (for the x2 runs button) instead of a full-width 

Penalty button (#7845) 

·        Fixed issue where the bowler for a new over would revert to the bowler of the previous over at that end, 

when either using Escape or Undo on that first ball of the new over (#7695) 

·        Fixed issue where adding a Penalty to a team who has already batted incorrectly updated the Fall of 

Wickets (#7911) 

·        Fixed issue where the last Drinks break’s end time in a first innings would update with the end of innings 

time when ending that innings, and also prevented the erroneous auto-Tweet for the Drinks break sent at the 

same time (#7924) 

·        Fixed issue where the software would incorrectly display the Trial Expired message and then close, which 

would have been very problematic if no internet connection available, as user would not be able to login 

(#7594) 

·        Fixed issue where an incorrect Revised Target would be calculated, despite the DLS Par Table being 

correct, if a reduction was manually changed between innings (#8110) 

·        Fixed issue where some files would be written to the default Match Folder at Documents\Cricket Matches 

even after this had been changed to a custom location (#8120) 

 *Replay Screen/Scoreboard* 

·        Added a Basic format with a specific Main slide that includes only core innings information for outputting 

to small Pavilion TVs or recreational-size LED screens (#5156) 

·        Added Configuration -> Scoreboard option to Prefix player names with their shirt numbers for display on 

all formats (#6777) 

·        Added a Teams slide to display both squads Pre-Toss and the final Playing XIs post-Toss, with shirt 

numbers if the above option is enabled, and (if known) the on-field Umpires (#6413) 

·        Enabled the Auto (Once) and Auto (Repeat) functions to work pre-Toss, using the new Teams slide and 

Toss slide (#8060) 

·        Added three new Holding slides (Break, Resumption, and Countdown) available during breaks, on all full-

screen formats, which display the type and Resumption Time (if known) and count down to the resumption of 

play (#3604) 

·        Added the ability to include the Time and Resumption Time (if known) to Custom Messages, via an 

Include Clock checkbox adjacent to the Show Message button (#3134) 

·        Added the Break type or Resumption Time (if known) at bottom-left and the Current Time at bottom-right 

of the Innings slide, on all full-screen formats, and replaced the Target slide in the Auto sequence as it contains 

this information (#4477) 

·        Added the number of overs bowled with the current ball in brackets after the total number of Overs in the 

innings, on the Large format (#331) 

·        Added the Cut-Off Time below the Clock, as per the Large format, to the Small and Medium (4-innings 

matches only, because of the Power Play information) formats as well (#476) 

·        Added Over Rate (between overs) to alternate with Overs (during overs), as per the Large format, to the 

Square, Small, and Medium formats (#928) 
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·        Added DRS values for 2-innings matches at the top-right of the Large format only, underneath the Power 

Play information. Care with Team name and abbreviation length will need to be taken with 1:1 and 4:3 aspect 

ratios (#3601) 

·        Added a new Summary slide that displays the highest batsmen’s scores and best bowlers’ figures for each 

innings, showing the top four in the first two innings, top two in the third innings, and top one in the fourth 

innings (#6563) 

·        Improved the Clock slide by increasing the font size and adding seconds to the hour:minutes previously 

displayed (#8041) 

·        Updated the Main (Large), Innings and three Target slides to denote overs/balls remaining as a minimum 

in the 4th innings, or in the 2nd innings of a multi-day match with no maximum overs per innings set, using 

‘MIN REM’ or ‘(min)’ (#5374) 

·        Fixed issue where the Clock would not update when in the Pre-Toss state (#7660) 

·        Fixed issue where a cancelled replay, i.e., after it had started but Start Ball had been clicked for the next 

delivery, was cancelling the pre-roll but still play the video replay, so that nothing plays at all after cancelling 

(#7408) 

*Match Centre* 

·        In multi-day matches, changed overs remaining to show ‘(min)’ to denote that these are the minimum 

overs remaining, in both Summary data display and match situation line, as per #5374 change (#7320) 

*Video/Capture* 

·        Added Multi-Camera support for live streaming and video analysis/clipping, with a maximum of four 

camera feeds and the ability to capture clips from the combined feed including redesigned add/edit Capture 

Device screens (#3346) 

·        Added ability for Pan, Tilt, Zoom (PTZ) control of ONVIF IP cameras via the IP Camera Controls panel, 

accessible via the Video Display -> Settings cog or View -> Video menus, for pre-match setup purposes 

(#2795) 

·        Added ability to capture, stream, and remote Interlaced video, by disabling new Progressive video 

encoding option via Configuration -> Advanced Video Settings -> Convert Interlaced Video to Progressive 

(#7935) 

·        Added detection and instruction messages to force users to remain on Blackmagic Desktop Video v11.6, 

given device detection issues with later versions including 11.7 and 12 (#7937), with a direct link to download 

11.6 (#8028) 

·        Added Configuration presets for Software and NVIDIA video encoders to control the quality/performance 

trade-off, with separate settings for Video Capture (including Remote Video) and Live Streaming (#7971) 

·        Added simplified performance options to Video Capture configuration, e.g., ‘Reduce high Frame rates 

automatically (30 fps max)’ and ‘Reduce source video resolution automatically (720p)’ (#7663) 

·        Added Auto-Detect video settings and warn if encoding settings, e.g., NVIDIA graphics card, are not 

optimal for detected hardware and option to automatically update configuration (#6509), ensuring the Hardware 

Encoding and Decoding checkboxes are disabled if these are not supported by the laptop (#7741) 

·        Added automatic fallback to Software Encoding & Decoding when Hardware Acceleration is not 

supported by laptop (#7726) 
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·        Added a Configuration -> Clipping option to Pause encoding during high CPU activity, e.g., ball clip 

playback, live scrubbing or streaming replay, VPM package creation, and replay screen replays, after which 

encoding will resume  (#7659) 

·        Added the non-default option in MP4 files for fast loading of unencoded (HD) Ball Clips and Continuous 

Video, to improve performance of these clips and make consistent with encoded (web) clips and VPM packages 

(#7853) 

·        Added new Network Stream Capture Device including fix where the SRT latency setting was sometimes 

preventing connecting to an SRT stream (#7627) 

·        Added preview of new Window Capture feature to aid procurement from other sources such as streaming 

via browser (#3696) 

·        Added an error message when attempting to login to ONVIF device via IP Camera Search with the 

incorrect credentials (#8038) 

·        Improved process for uploading long Continuous clips, to minimise the occurrence of Out of Memory 

exceptions (#7321) 

·        Improved support for NDI streams, OBS, and vMix virtual devices, which are now options under Video 

Capture Device -> Other Devices and Cameras, so can be accessed and loaded from there (#7685) 

·        Improved the auto-discovery search function for IP Cameras on the network, to assist with the secure 

setup of NV Play hardware/camera packs (#7668) 

·        Improved the accuracy and responsiveness of the reported CPU% in Live Video Statistics and Status Bar, 

so that it more closely resembles the Task Manager value (#7667) 

·        Improved the background delete and auto-capture process when using non-default drive locations for 

video capture (#7742) 

·        General performance improvements to the Video Player, to minimise impact on user interface thread and 

CPU usage, and including a new Reduce Quality setting for video sources >30 frames per second and fixed 

application slowdown from frequent use of Video Player or Auto Replay (#7582) 

·        The Video Display -> Mute Audio in Player setting will now be retained after restarting the software 

(#7874) 

·        Added an External Audio Delay function to adjust the incoming audio to remain in-sync with the video, 

e.g., if the audio commentary is out-of-sync with the live video (#7969) 

·        Improved the duration estimates of Continuous Capture files (#7883) and fixed issues with deleting .ts 

files when Video Display was showing Continuous or live scrubbing videos (#8024) and when recording from 

an IP camera (#8025) 

·        Improved the auto-detection of the video source’s format (resolution and frame rate) for devices that do 

not know this immediately, and update display in Live Video Statistics (#7875) 

·        Improvements to the Live Video Statistics panel, including adding Data Rate in Kbps for Remote Video 

and Live Streaming (and Mbps), and changes to Video Format to show the converted frame rate and resolution 

actually being used (#7967) 

·        Improved performance of video source at higher frames per second, e.g., when playing highlights 

packages into live streams at 60fps (#8047) 
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·        Improved the information displayed in the Video Player, by adding Match and Innings column when 

viewing ball clip sequences across multiple matches, and the Innings column when viewing ball clip sequences 

from a single match (#6720) 

·        Improved the handling of audio in multi-cam setups, including new option to consistently apply the audio 

associated with the primary video input across other video inputs, with external audio from individual inputs 

disabled by default (#7922) 

·        Updated the software to run as a 64-bit application (#7729), and implemented new Media Components, 

v2.4.2, supporting both 32 and 64-bit machines (#7665) 

·        Replaced software-based video encoder with x264 (commercial version), which is known as the best 

software encoder in the world, providing much better quality, performance, and control when hardware 

acceleration is not available (#7744) 

·        Simplified the user interface for Configuration -> Video Capture/Advanced settings, especially for 

encoding and decoding (#8004), plus other tweaks like a direct link to these settings from Video Display when 

No Video displayed (#8020) 

·        Relocated and streamlined video capture Advanced Settings, now under each Capture Device type with 

Show/Hide function and appropriate settings only (#7737) 

·        Simplified the Video Capture configuration for Video Encode and Decoder settings (#7739) 

·        Fixed issue where an NDI stream would auto-connect to the first stream found, preventing the ability to 

connect to multiple NDI streams (#7837) 

·        Fixed issue where Auto-Replay would unnecessarily cause Video Display to reconnect to the video 

capture device after initial install of Media Components (#8029) 

·        Fixed issue on some machines where .ts files were not being removed after Continuous Capture is ended 

(#7589) 

·        Fixed issue where Playback Capture from some imported videos would sometimes only capture very short 

ball clips (#7873) 

·        Fixed issue where the Video Player on a Reader would not close after playing an Auto-Replay, causing a 

crash when it attempted to play the next Auto-Replay (#8119) 

 *Live Streaming* 

·        Improved timings for auto-replays, e.g., when the Live Scorer scores the ball before the Video Analyst has 

ended the ball clip recording (#7458) and the Live Scorer closes the Confirm Batsman and End of Over score 

check dialogs (#7618) 

·        Added a Configuration -> Live Streaming option to ‘Disable Overlay Graphics Animations between 

different overlays’ to improve performance by reducing CPU load (#7781) 

·        Added a dialog to prompt to synchronise the laptop date/time to the Windows Time Service to improve 

the timing of Auto-Replays when streaming is occurring on a machine independent of the Video Analyst 

(#7406) 

·        Added warning messages when trying to Live Stream at a resolution (e.g., 1920x1080) higher than the 

video source (e.g., 1280x720), which will cause performance issues (#8006) 

·        Improved audio quality by increasing the Default Sample Rate to 48KHz and encoding at 160Kbps 

(#7963) 
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·        Added NDI output for live streaming, including support for Alpha Channel (transparency), for integration 

into third party software such as vMix which can cleanly apply the graphics over the top of other video sources. 

Allows for full scoring overlay support, optional watermarks, and Video Package Manager playback in live 

streams produced externally from NV Play Cricket (#8056) 

·        Improved the performance of graphic overlays and animations, especially at higher frame rates, including 

a fix to the issue where the overlay would sometimes flash on-and-off (#7975) 

·        Improved the performance of instant replays and the playback of highlights packages by removing 

unnecessary streaming format conversions (#8012) 

·        Improved the Auto Replay setup process, so that these are immediately enabled when Activations are 

selected, and added Information icons to e.g., stress that Auto or Auto with Cards must be selected for replays to 

automatically play (#6993) 

·        Changed the Stop Replay function from a sudden cut to a smooth transition, and also applied this to the 

end of video file playback even if manually stopped early (#5228) 

·        Prevented the Match Type -> Overs per Day setting appearing as “Overs Remaining Today” on the 

overlays in two-innings matches, i.e., counting down from 40 in a Twenty20 match (#6851) 

·        Fixed issue where sometimes the small output window would be grey after starting a stream, even though 

the stream itself was playing the live video feed (#7431) 

 *Video Package Manager* 

·        Improved calculation of VPM’s maximum durations by considering the transition between clips (#7323) 

·        Fixed issue where Stats Wizard highlights packages would not create correctly when local web clips were 

stored in a non-default file location (#7568) 

·        Fixed issue where local unencoded clips would not be identified and included if there is no equivalent web 

clip, and showing cloud icon on thumbnail (#7846) 

·        Fixed issue where scrambled audio would be played at the end of a highlights package with full screen 

cards, when the last the last clip is not long enough for the card display duration (#7743) 

   - Fixed issue where Stats Wizard highlights packages would not create    correctly when local web clips were 

stored in a non-default file location    (#7568) 

·        Fixed issue where sometimes some ball clips would not be added to long highlights packages due to error 

loading video files (#7592) 

·        Fixed issue where ball clip durations would change after download, overall package duration would 

sometimes be incorrect, and the exported XML timestamp for the final ball would therefore be incorrect as well 

(#7309) 

·        Fixed issue where the Trim Start and Maximum Length settings were not being applied to downloaded 

ball clips when using the multi-match Stats Wizard (#7974)  


